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1.

PREPARATION DE L’ENVIRONNEMENT DE
DEVELOPPEMENT

Installation du SDK

Etant donné qu’Android est basé sur le langage Java, il faut tout d’abord installé le JDK 6 sur le

site de Sun.

http://java.sun.com/javase/downloads/widget/jdk6.jsp

Ensuite, on peut télécharger le SDK de Google Android.

http://code.google.com/android/download.html

On décompresse I'archive. Le dossier s’appellera :

android_sdk_windows_ <releases>_<build>

On y fera référence sous la dénomination <répertoire_sdk=>.

2.

Ajout du répertoire du SDK dans la variable d’environnement PATH

Clic droit sur le Poste de travail et sélectionnez Propriétés

Dans I'onglet Avancé cliquez sur le bouton Variables d’environnement

Une boite de dialogue apparait, double-cliquez sur I'’entré Path présente dans la partie
Variables Systémes. On y ajoute le chemin <répertoire_sdk>\tools.

Plugin Eclipse

Démarrez Eclipse puis sélectionnez le menu Help > Software Updates > Find and
Install...

Sélectionnez Search for new features to install et appuyez sur le bouton Next
Appuyez sur le bouton New Remote Site

Dans la boite de dialogue qui apparait, indiquez un nom (par exemple Android Plugin)
et I'URL https://dl-ssl.google.com/android/eclipse/

Appuyez sur le bouton OK

Le site est ajouté a la liste et sélectionné. Appuyez sur le bouton Finish

Sélectionnez Android Plugin et appuyez sur le bouton Next

Lisez la licence d'utilisation, sélectionnez I'option 1 accept the terms in the license
agreement et cliguez sur le bouton Next , puis sur le bouton Finish

Le plugin n'est pas signé, un message vous le signale, appuyez sur le bouton Install All
Redémarrez Eclipse

Une fois Eclipse redémarré, sélectionnez le menu Window > Preferences...
Sélectionnez Android dans le panel de gauche

Indiquez le chemin ou vous avez installé le SDK Android (bouton Browse pour
parcourir le systeme de fichier)

Appuyez sur le bouton OK
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1. SDK

1. Lancement et utilisation du SDK

Lancer le SDK. On arrive sur cette page :

-
‘" Android 5DK and AVD Manager

Virtual Devices

Available Packages
Settings
About

[T — SDK Location:  C:\Pregram Files\Google\android-sdk-windows

Installed Packages

Documentation for Android SDK, APL7, revision 1

I Android SDK Tools, revision 4

' SDK Platform Android 1.1, AP1 2, revision 1

' SDK Platform Android 1.5, AP 3, revision 3

%' SDK Platform Android 1.6, APT4, revision 2

%' SDK Platformn Android 2.0, APLS, revision 1

%' SDK Platform Android 2.0.1, APIG, revision 1

%' SDK Platform Android 2.1, APL7, revision 1

‘B Google APIs by Google Inc., Android API 3, revision 3
'E Google APIs by Google Inc., Android API4, revision 2

e e el AT e Pl Teee Aeedenid ARTE amedalio.w d

m

Description

Delete...

On sélectionne I'onglet « Virtual Devices » afin de créer une nouvelle cible.

-

‘i Android SDK and AVD Manager - I

Installed Packages
Available Packages
Settings

About

)

List of existing Android Virtual Devices:

AVD Name Target Name
~ avdll Google APLs (Google Inc.)
w avd3 Google APIs (Google Inc.)

API Level

7
3

New...

Delete...

Repair...

Details...

Start...

Refresh

w A valid Android Virtual Device,

X An Android Virtual Device that failed to load. Click 'Details' to see the error,

On clique sur « New »

On arrive sur cette fénetre :
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Create new AVD ﬂ

Marme: |
Target: ’ v]
S0 Card:

&) File: Browse...
Skin:

@ Built-in:

() Resolution: ¥
Hardware:

Property Value

Delete

Force create

On choisit un nom pour notre émulateur ensuite on choisit la version du firmware. On a
également la possibilité de choisir de taille pour la carte mémoire externe SD. On clique ensuite
sur Create AVD et voila, on a créé notre émulateur.

2. Se procurer une clé pour utiliser ’AP1 Google Map

Pour se procurer une clé Google Map. Il faut lancer tout d’abord le terminal.
On se place dans le bon dossier qui est celui du dossier tools du SDK.
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Microsoft Windows [version 6.1.76801
Copyright <c> 2009 Microsoft Corporation. Tous droits réservés.

C:sUserssJoseph DAOUD>cd _android
C:~Uzsers~Jozeph DAOUD . android>

-
BN Administrateur : C\Windows\system32\cmd.exe |£‘E‘ﬁ

Ensuite, on lance la ligne de commande

keytool -list -keystore debug.keystore

On nous demande d’entrer notre mot de passe. On tape juste entrée sans rien entrer.

Microsoft Windows [version 6.1.76801]
Copyright <c> 20809 Microsoft Corporation. Tous droits réservés.

C:~Users aJoseph DAOUD>cd _android
C:s\Users~Joseph DAOUDN.androidrkeytool —list —keystore debug.keystore

Tapez le mot de passe du Keystore :

b

BN Administrateur : C\Windows\system32\cmd.exe - keytool -list -keystore debug.keystore |ﬂ‘i‘J

On nous délivre ensuite un code.
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-
BN Administrateur : C\Windows\system32\cmd.exe |ﬂ‘éj

Microsoft Windows [version 6.1.76801
Copyright <c> 2009 Microsoft Corporation. Tous droits réservés.

C:sUserssJoseph DAOUD>cd _android

C:~Users~Jozeph DAOUD . androidrkeytool —list —keystore debug.keuystore
Tapez le mot de passe du Keystore :

WHUERTISSEME'NTW

intlgritd des informations enregistries dans votre Keystore =
a PAS 0td virifide ' Pour cela, =

ouz devez spiUcifier le mot de passe de votre Heystore.
e nnmnmmmx [ U E R T I § § E M E N T s s seu s

Tupe Keuystore - JKE
Fournizseur HKeystore : SUN

Jotre Keystore contient 1 entrieds}

androiddebugkey, 24 fivr. 20108, PrivateKeyEntry,
Empreinte du certificat ¢(MD5> - CB:Z2A:64:EV:FA:EF:93:D4:6A:6C:A7-BF:?E-F6:ED:95

C:~Users~Joseph DAQOUD~.android>

b

Maintenant, copiez ce code et il faut se rendre sur le site :

http://code.google.com/intl/fr-FR/android/maps-api-signup.html

Google p—
Code 8
Android Maps APl Key Signup Home Docs MapsBlag  Android Blog

Sign Up for the Android Maps API

The Android Maps AP lets you embed Google Maps in your own Android applications. A single Maps API key is valid for all applications signed by a single ifi . See this d ion page
for more information about application signing. To get a Maps AP key for your certificate, you will need to provide its the certificate’s fingerprint. This can be obtained using Keytool. For example. on
Linux or Mac OSX, you would examine your debug keystore like this:

oid/debug. X

If you use different keys for signing development builds and release builds, you will need to obtain a separate Maps AP key for each certificate. Each key will only work in applications signed by
the corresponding certificate.

You also need a Google Account to get a Maps AP key, and your AP| key will be connected to your Google Account.

Android Maps APIs Terms of Service

Wi

Last Updated: October 13, 2008

Thanks for your interest in the Android Maps APIs. The Android Maps
APIs are a collection of services (including, but not limited to,

the "com.google.android.maps.MapView" and "android.location.Geocoder™
classes) that allow you to include maps, geocoding, and other content
from Google and its content providers in your Android applications.
The Android Maps APIs explicitly do not include any driving
directions data or local search data that may be owned or licensed by
Google.

1. Your relationship with Google. -

v | have read and agree with the terms and conditions (printable version)
My certificate’s MD5 fingerprint: 94:1E:43:49:67:73:68:E6:A6:88:D7:20:F1:6E:B5:96

| Generate AP Key ‘

On entre notre code, on coche et on clique sur « Generate APl Key ».
On nous donne alors le code a utiliser :
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gle APl Google Maps
Maps

BETA Accueil Google Code > APl Google CMaps = APl Google Maps - Inscription
Merci de vous Otre inscrit pour obtenir une clO APl Android MapsO!
Voici votre clDO:
OndlGIggluwlglewH_=6CEASQI10SEEUALISgUD
Cette cIC fonctionne avec les applications signCes avec votre certificatD; 'empreinte digitale de celui-ci estC:
94:1E:43:49:87:73:BB:E6:A6:88:D7:20:F1:8E . B5:98
Voici un exemple de code xml qui vous aidera T commencer O exploiter efficacement nos outils cartographiquesD:

<com.google. android . naps. HapView
android: layout_width="fill_parent"
android: layout_height="{fill_parent"

android:apiley="0ndlGIggluvlglevH =6CEARQiI10SEEBuALISqUQ"
S

Consultez la documentation de 'API pour plus dinformations.

3. Entrer une géolocalisation

Pour cela, on repére tout d’abord le port de notre émulateur. Par défaut, c’est 5554.

f_—'r—[”[—r““[—“r““r“r—“(r—j

| : r_rf_r_[—rf—'[* f_f
!‘ 2 ﬂj r—{—f_[“r_“[_ F__"f_'
T_[—r_"f_{_

Contacts Browse Maps

Joseph DAOUD — Ecole Polytechnique de Montréal




On lance ensuite un TelNet et on entre le port 5554. L’h6éte est localhost.

ﬁ PuTTY Cenfiguration L% |-

Category:

—|- Session Basic options far your PuTTY session

. -Logging ct to
=1 Teminal Pl

Koyboard S oL |P oddress)

- Bell localhost . 5554
... Features H rr—

= Window

- Appearance

- Behaviour
.. Trarslation Saved Sessions

Specify the destination you want to conne

Load, save or delete a stored session

- Selection

- Colours . R
Default Settings
—|- Connection |ﬂ|

- Data | Save |

Close window on exit:
Always Mever @ Only on clean exit

About | | Help | Qpen | | Cancel

On arrive sur cette fenétre.

@ Joseph-Laptop - PuTTY | =RRch X

f commands
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11 suffit ensuite de taper la commande :

Geo fix <latitude> <longitude>

Par exemple, si I'on rentre les coordonnées de New York City :

Geo fix -73.9 40.667

On valide (il est normal qu’il nous donne un KO la premiere fois, aprés c’est OK).

F |
Joseph-Laptop - PuTTY |ﬂl'-z—hj

Si I'on se rend ensuite dans Google Maps, on voit que I'on est bien a New York City.
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111. QUELQUES CONSEILS

1. Terminate

Il se peut que lorsque I'application plante en mode Debug, aucune erreur ne soit renvoyé, il faut
alors aller dans la vue Debug et faire un terminate. Alors I’erreur apparaitra.

2. Log cat

Le log cat est I'’équivalent du System.out.println du Java classique. A utiliser pour déboguer.
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1V. HIERARCHIE D’UN PROJET

Allez dans File > New > Other > Android Project, une boite de dialogue apparait :

& New Androbd Project

Mew Android Project
Creabes a new Androad Project rescurce, CI

Projact name: | MyFirstandrsidProject
‘mnbents
& Creste v projack i workspats
Creabs projact from existing souroe
o | Lisa e sl locartion

Package nama: o, cyrilmotiier  andnod, butorisl
Bickivity namea: PartOne

Bpphcabion name:  Part One

1l est nécessaire de remplir tous les champs :

Project Name : Ce nom de projet est totalement indépendant de votre application Android. Ce
n’est en fait que le nom donné a votre projet dans Eclipse (nom donné au dossier dans votre
workspace).

Package Name : Nom du package principal de I'application. Le package définira en fait le nom
interne de I'application sur le terminal Android.

Activity Name : C’est le nom de I'activité qui débutera au lancement de votre application. Le
nom d’activité sera automatiquement ajouté au AndroidManifest.xml (fichier qui décrit
I'application au systéme Android et qui sera expliqué plus en détail un peu plus loin)
Application Name : Il faut rentrer un nom pour I'application. Cette chaine de caractéere sera
également inscrite dans AndroidManifest.xml et sera en fait utilisée par le systeme lors de
I'affichage des applications dans I’écran d’accueil. C’est en réalité le nom de I'application affichée

sous l'icbne de I'application.

Apres avoir validé la boite de dialogue précédente en cliquant sur “Finish”, on se retrouve
maintenant en présence d’un projet type Android. Ce projet suit une arborescence bien précise :

Joseph DAOUD - Ecole Polytechnique de Montréal 11



4 TEGI- MyFirstandroidProject
a8 g
483 com.cyrilmottier, android. tutorial
o [J] Partone.java
] R java
4 B Android Library
e android.jar
[= assets
4= res
4= drawable
2| icon.png
4= layouk
X| main.xml
[ values
X| skrings.xml
€1 AndroidManifest <l

Comme a I'accoutumée, Android ne déroge pas a la régle et insére donc les différents packages
dans le dossier src. C’est dans ce dossier que I'ensemble des fichiers de code (.java) doivent se
trouver. Il est bien sr possible de créer de nouveaux packages comme les développeurs Java
ont I’habitude de le faire. Analysons maintenant le contenu du

package com.cyrilmottier.android.tutorial. On y retrouve tout d’abord un fichier PartOne.java qui
n’est autre que l'activité (Activity) principale de I'application. Un simple coup d’oeil au code
contenu dans le fichier montre que PartOne hérite bien d’Activity :

package com.cyrilmottier.android.tutorial;

import android.app.Activity;
import android.os.Bundle;

public class PartOne extends Activity {

/** Called when the activity is first created. */

@Override

public void onCreate(Bundle savedlnstanceState) {

super.onCreate(savedlnstanceState);
setContentView(R.layout.main);

¥
¥
En dessous du dossier src, on retrouve un fichier android.jar. C’est tout simplement ce jar qui
contient 'ensemble du framework Android. Sans ce dernier, notre projet Android serait tout
simplement une coquille vide.
On retrouve ensuite dans le package par défaut le fameux R.java. Ce fichier est
automatiquement géré par ADT et n’est donc pas modifiable par I'utilisateur. Ce fichier contient
en fait I'ensemble des références vers les ressources de votre projet. Imaginons par exemple
que nous souhaitions utiliser une image (Drawable dans le langage Android), on y accedera
par R.drawable.nom_de_| _image.
Au méme niveau que le dossier src, on retrouve un dossier nommé assets et qui contient
simplement des données qui seront chargées sur le mobile lors de la compilation de votre
projet. Les données inclues dans ce dossier ne sont normalement pas en accord avec
I'arborescence classique d’un projet Android : cela peut, par exemple, étre des fichiers texte
décrivant la license de votre application, des fichiers audio ou vidéo, etc.
Un projet Android contient enfin un dossier res qui regroupe I’ensemble des ressources relatives
au projet. C’est ce dossier qui est “lu” par ADT pour créer le fameux R.java. Ce dossier contient
lui méme des sous dossiers regroupant les ressources selon leur type. A la création d’'un projet
Android, les sous-dossiers créés sont :
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drawable : regroupe I'ensemble des images (png, jpg, gif), Drawables, etc.

layout : le framework Android a I'avantage d’offrir une technique de création d’interfaces
graphiques a I'aide de fichiers XML. C’est dans ce dossier que I'on inclue I'ensemble des fichiers
décrivant l'interface.

values : ce dossier contient également un ensemble de fichiers décrivant les valeurs utilisées
par votre application. On peut, par exemple, y mettre des chaines de caractéeres (strings.xml),
des tableaux (arrays.xml), des couleurs, des dimensions, etc...

Pour finir, tout projet Android contient un fichier nommé AndroidManifest.xml qui définit le
comportement de I'application au systeme Android. Ce fichier définit par exemple, le nom,
I'icone (par défaut drawable/icon.png), le théme, la version minimale du systéme nécessaire a
I’'exécution de I'application, les activités, les services, etc. de I'application.
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V. HELLO WORLD

Tout code Android devra se faire dans le cadre d’un projet Eclipse. Pour créer un projet, on va
dans “File” > “New” > “Project...”.

& Java - Eclipse Platform
File! Edit Run Navigate rch Project Refactor Windou Hals

New + > &2 Java Project

n File. . N Project...

L2y Import.

Créez un nouveau projet de type Android :

Joseph DAOUD - Ecole Polytechnique de Montréal
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http://www.e-vidence.net/wp-content/uploads/2009/06/menu_projet.png�

& New Project

Select a wizard

P = General
~ = Android

P = CVS
P = Java

3 Android Project

P = Examples

On passe ensuite a I'étape de configuration du projet :
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http://www.e-vidence.net/wp-content/uploads/2009/06/android_project.png�

Creates a new Android Project resource. q 3

1 Project name: |HelloWworld ‘

Contents
© Create new project in workspace
[ Create project from existing source
Use default location

Iz

Build Target
: Target Name Vendor Platform APILe| ™
[ Android 1.1 Android Open Source Project 1.1 2
2 Android 1.5 Android Open Source Project 1.5 )
] Google APIs Google Inc. 15 3 v
Standard Android platform 1.5
Properties

Application name: IHeIIoWorId

Package name: lword.hello{

|
|

Create Activity: IHeIIoWorId l 3
|

Min SDK Version: |3

I Finish ” Cancel

Il ne reste plus qu’a faire un clic droit sur le projet et sélectionner « Run As > Android
Application ».
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http://www.e-vidence.net/wp-content/uploads/2009/06/set_up_projet.png�

‘android/apis/MapViewDemojjava - Eclipse . .0
rch Project  Refactor I'Windmu] Help

start client start server New Window r= )‘?
= Mew Editor

13 strings.xml (‘E ii st
. Open Perspective * k, 75,
] Show View P rue);

Custemnize Perspective...

X Save Perspective As...
Reset Perspective...
B
Close Perspective
Close All Perspectives 3
255, 2f
Mavigation b krue);
e . STHO!

B Android SDK and AVD Manager

Preferences

n(2):

return borderPaint;

T

1l faut choisir dans les options la cible sur laquelle s’exécute notre projet.
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] Ml @ 8:36 PM

HelloWord

Hello World, HelloWord!

MENU

M X O m w

i [ g B = S =
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VI. DESINSTALLATION D’UNE APPLICATION

On peut avoir besoin de désinstaller une application. Pour cela, il suffit de lancer un terminal et
de lancer I’émulateur ou I'on souhaite désinstaller I'application.

Il suffit ensuite d’entrer :

adb uninstall nom_du_package

BN Administrateur : C\Windows\system32\cmd.exe

Microsoft Windows [version b6.1.76801]
Copyright <c> 20809 Microsoft Corporation. Tous droits réservés.

C:“Uzers-~Jozeph DAOUD>adb uninstall org.exanple.android.apis
Buccess

IC:~Uzers~Jozeph DAOUD>
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